
 

hen you first brought your computer home, everything was simple. Most of the software was 
installed. Nothing was compressed. You could doubleclick on anything to open it. But when you 
start downloading new software to your computer, you have to rethink the way you do things. 
Doubleclicking a file may not open it. You may have to install fonts, sounds, and other software 
into your system. This chapter helps you sort out the confusion.

8.01    Where are the files I downloaded?

AOL normally downloads files to the Online Downloads folder, which is inside the America 
Online folder. However, you may have told AOL to put the files elsewhere. System 7 users can 
use the Find command under the Finder's File menu to search their hard disk for the file. System 
6 users who have the Find File DA can use that to search for the file.

Have you forgotten the file name? If you can remember part of the name, search for that part. 
When using the Find command, you'll have more success if you search for fewer letters. The 
more specific you try to be, the more likely you are to make a mistake. When searching for files, 
don't search for the extension (such as ."sit" or ".sea"). If you had auto-unstuffing turned on, 
AOL unstuffed the file, which eliminated the extension.

If you can't remember the name of the file, there's a way to find out. Choose Download Manager 
from the File menu and click the "Show Completed Downloads" icon. You'll see a list of your 
fifty most recent downloads.

8.02    Why can't I just doubleclick files to open them?

Normally, opening a file on the Macintosh is as easy as doubleclicking it. Doubleclick a 
spreadsheet and it opens in your spreadsheet program. Easy as that. If you understand how this 
works, you'll be better able to understand why it sometimes doesn't work.

On the Mac, all files have a type and creator code. The Mac uses these codes to decide which 
applications can open which files. Here are some example type and creator codes:

                      FILE                                  TYPE            CREATOR
____________________________    ________    __________
    TeachText application                  APPL              ttxt        
    TeachText text file                      TEXT              ttxt
    TeachText read-only file            ttro              ttxt



    System 7 screenshot                      PICT              ttxt
    MacWrite II application              APPL              MWII
    MacWrite II text file                  TEXT              MWII
    MacWrite II native file              MW2D              MWII

From looking at the above table, you might notice two things. First, one program can create 
documents with different type codes. Second,    certain file types, such as files of type TEXT, can
be opened by more than one program.

If you doubleclick a TeachText text file (TEXT/ttxt), the Mac looks for an application (type 
APPL) which has a creator code of ttxt. The Mac then launches TeachText (APPL/ttxt) and opens
the file with TeachText.

What happens if you download a plain text file (type TEXT) that was created with MacWrite 
(APPL/MWII)? If you have MacWrite on your computer, you can just doubleclick the file to 
open it. If you don't have MacWrite, the computer will report that the application that created the 
document could not be found.

However, TeachText knows how to open files of type TEXT. Just launch TeachText and choose 
Open from the File menu. Navigate to the folder where the MacWrite document is stored, select 
it, and click Open. This is the standard way to open files that won't open when doubleclicked. 
The trick is knowing which applications open which file types.

System 7 made the process somewhat easier. First, TeachText was given the ability to open 
PICTs. Second, if the application which created a PICT or TEXT file can't be found, System 7 
will offer to open the file in TeachText. Third, System 7 supports drag and drop: drag a file's icon
over an application's icon. If the application can open the file, the application hilites. If you drop 
the file (release the mouse button) while the app is hilited, the file will open in that application. 
Note that drag and drop doesn't always work. If drag and drop fails, try using the application's 
Open command.

IBM PCs don't use type and creator codes. Instead, they use extensions. For example, the 
extension for Microsoft Word files is ".doc". The file name might look like "readme.doc". To 
open documents created on an IBM PC, you'll generally need to use your application's Open 
command. Some utilities (Apple's Macintosh PC Exchange, Insignia's AccessPC, etc.) can map 
DOS extensions to Macintosh type and creator codes. So for instance you could doubleclick 
".doc" files and have them open automatically in Microsoft Word on your Macintosh.

You can learn more about type and creator codes by using File Buddy by Laurence Harris 
(LHarris). File Buddy allows you to change a file's type and creator codes, as well as other 
information that the Finder uses. VendorTC by Bill Baldridge (FourArts) lists the type and 
creator codes for many popular applications. Both programs are available on AOL.

8.03    How do I open files ending in .sit, .cpt or .sea?

The files you downloaded are archives created by a compression utility. Archives have two 
advantages over unaltered files. First, the files are compressed, so they take significantly less 



time to download. Second, a single archive can contain multiple files, which simplifies 
downloading.

AOL's current policy is that Macintosh archives must be either in StuffIt format (indicated by the
.sit extension) or in a self-extracting format (indicated by the .sea extension). Self-extracting files
are applications that contain the archive and the code needed to decompress the archive. Some 
older files are in Compact Pro format (indicated by the .cpt extension).

You can set AOL to automatically unstuff .sit files after you finish the download and sign off. 
Choose Preferences from the Members menu, click Downloading Preferences, and put a check 
mark by the Auto-Expand Files option. 

SIT.    To open a StuffIt file with AOL 2.0 or 2.1, choose Open from AOL's File menu, set the 
Show menu to All Known Documents, and select the file. AOL will automatically unstuff the 
file. If you have an earlier version of AOL, download Aladdin System's free StuffIt Expander. 
Expander can open StuffIt, Compact Pro, BinHex 4.0, and AppleLink archives. (Note that StuffIt
1.5.1, StuffIt Classic, StuffIt Deluxe 2.0, and UnStuffIt Deluxe can't open files created with 
StuffIt 3.0.)

AOL can automatically unstuff .sit files. Choose Preferences from the Members menu, then click
Downloading Preferences. If you put a check mark by the Auto-Expand Files option, AOL will 
decompress any .sit files after you sign off. This option is on by default.

SEA.    To open a self-extracting file, doubleclick it. It will prompt you for a destination for the 
decompressed files. Choose a destination, then click the Extract or Save button. After you've 
extracted the files, the .sea file isn't needed any more. You can throw away the .sea to save disk 
space.

CPT.    To open a Compact Pro file, you'll need either Compact Pro (shareware by Bill 
Goodman), CPTExpand (freeware by Bill Goodman), StuffIt Expander (freeware by Aladdin 
Systems) or StuffIt Lite (shareware by Aladdin Systems). Compact Pro files aren't allowed any 
more, but some older files are in Compact Pro format.

8.04    How do I compress files with AOL 2.1?

At some point you'll probably need to compress files on your hard drive. Maybe you're running 
out of space, or you need to make a large file fit on a floppy disk. AOL 2.1 can compress files 
into StuffIt format.

Instructions
1.    Launch AOL 2.1 and choose Compose Mail from the Mail menu.
2.    Fill in the To field. Then click the Attach File button.
3.    In the dialog box that appears, select the files you want to compress and click the Add button 
to move them into the right hand window.
4.    When you've added all of the files to the archive, put a check mark in the Compress Files 
check box. Then click the Attach button. Note where the file is being saved.



5.    Click the Detach File button. The compressed file will be stored on your hard drive exactly 
where you left it.

8.05    How do I open files ending in .zip or .arc?

Zip and arc files are the IBM PC equivalent of sit and cpt files. On AOL, you'll find these files in
the PC forums, as well as in forums that are not exclusively for Macintosh users. Zipit, described
in the software section of the FAQ, can compress and decompress files in zip format. 

AOL 2.1 can expand zip and arc files automatically if auto-expanding is turned on in 
preferences. You can unzip and unarc any file by launching the AOL software, choosing Open 
from the File menu, and selecting the file. 

                                America Online's zip translator appears to be broken. 
                           When unzipping a file, AOL reports that the file may
                                be corrupted, and it usually is. When downloading 
                                zipped files, I recommend turning off the auto-expand
                                option in preferences. After the download, unzip the 
                                file using ZipIt.

Once you've decompressed the zip file, you may or may not be able to use it. If it's a text file, 
you can probably open it in your word processor.    If it's a graphic in a universal format (GIF, 
JPEG, etc.), you can probably open it with GIFConverter, GraphicConverter, and the like. 

DOS games and other DOS applications won't work on a Macintosh. IBM applications won't run
on a Mac unless you have the payware SoftPC or SoftWindows program, an Orange Micro 
expansion card (~$600), a Centris 610 or Quadra 610 with a DOS card (~400), or a PowerMac 
running SoftWindows. You can spot DOS applications because they end in ".exe" or ".com".

8.06    How do I open Read Me files and docs?

In some cases, you can just doubleclick the file to open it. This won't always work, because you 
may not have the application that created the document. For instance, shareware documentation 
is often in MacWrite format. Few people use MacWrite anymore, but most word processors can 
open MacWrite files.

If doubleclicking the file produces an "application not found" error, launch your word processor 
and choose Open from the File menu. If your word processor can open the file, the file will 
become visible in the Open dialog. Select the file and click the Open button.

                                Some word processors have a popup menu in the Open 
                           dialog for selecting what kinds of files to open. If your word 
                                processor has such a menu, set it to something like "all known 
                                files" or "all readable files". In ClarisWorks, you'll see a popup
                                menu called Documents. Set it to "Word Processing".



                           Microsoft Word has a setting to open "All Files". With this 
                                option, you can literally open any file, even an application! 
                                Naturally, applications aren't word processing files, so you'll 
                                just see a bunch of gibberish. It's kinda cool to look at, though.

If you're using System 7, you may be able to open the file via drag and drop. Drag the file's icon 
over your word processor's icon. If the word processor's icon turns black, drop the file's icon on 
it. The file will open in your word processor. This only works if your word processor knows how
to read that kind of file. The Open command will open some files that won't open with drag and 
drop.

If you doubleclick a plain text file, the Mac may offer to open it in TeachText. In some cases you 
may get the message "This document is too large to be opened by TeachText", because 
TeachText can't open text files larger than 32K. If the text file is larger than 32K, try opening the 
file in your word processor, using the program's Open command. BBEdit Lite and SaintEdit can 
open large text files, and are available on AOL.

8.07    How do I open QuickTime movies?

QuickTime is Apple's format for multimedia. QuickTime integrates pictures, animation, sound 
and text in a standard format. Compression is a standard part of the format, and is necessary to 
reduce sound and graphics information into a reasonably-sized file.

You'll need five things to view QuickTime movies:

1. The right Macintosh    QuickTime requires a Macintosh with a 68020 processor or higher.
Basically, that means any Macintosh except the 128K, 512K, Plus, SE, Classic, Performa 200, 
Portable, or PowerBook 100.
2. System 7.0    QuickTime won't work with any version of the system software lower than 
System 7.0.
3. Apple's QuickTime extension    The QuickTime extension is available in the Macintosh 
Operating Systems Forum (keyword "mos").
4. A QuickTime movie    There are a variety of QuickTime movies on AOL. Do a file search 
for "quicktime movie" or search the file library in the Macintosh Graphics Forum (keyword 
"mgr").
5. A movie player    Apple has a great program called MoviePlayer, but it's not available on 
AOL. The freeware MoviePlay by Ed Anuff is nearly as good. Other downloadable movie 
players include Popcorn, MacVCR, Easy Player, QT Player, and HyperMovie Player. (QT Player
and HyperMovie Player require HyperCard 2.1 or higher. HyperCard is not available on AOL.)

A QuickTime player is built into the AOL FAQ. To open a QuickTime movie, click the button 
below:

 



lick here to open ---->
QuickTime movies --->

8.08    What are GIFs?

GIFs are pictures in the Graphic Interchange Format (GIF). The word is pronounced "jif", as in 
JIF peanut butter. GIFs have several advantages over other graphics formats:

1.    GIF files have built-in compression, so they take less time to download than files in other 
graphic formats, and take up less space on your hard drive. You don't have to manually compress
or decompress GIFs. GIF viewers perform the compression automatically.
2.    GIFs never use more than 256 colors, so you don't need an expensive video card to view 
them. The 256 color limit also reduces the file size.
3.    GIF is a cross platform format. GIF viewers exist for many computer types, including 
Macintosh, Apple ][e, Apple ][gs, DOS, and Windows.

                                Compu$pend originally developed the Graphics Interchange 
                           Format so members could download color weather maps. 
                                Today the most common use of GIFs is to transfer X-rated
                                pictures through BBSes. There are no X-rated files on AOL, 
                                but the Macintosh Graphics Forum (keyword "mgr") 
                                does have R-rated GIFs.

8.09    How do I view GIFs, PICTs, JPEGs, and other pictures?

Graphics files are some of the most popular downloads. The most common graphics formats are 
GIF, PICT, Startup Screen, MacPaint, and JPEG. After you download the file, you'll need the 
correct software to view it.

Some shareware programs can open more graphics formats than the payware programs. For 
instance, GIF pictures are incredibly popular, but only a few payware programs can open them. 
Adobe PhotoShop (~$500) is one of those programs. There are two shareware graphics viewers 
that I recommend: GIFConverter and GraphicConverter. Both are high quality programs that can 
open and save numerous graphics formats. 

I've used GIFConverter in the past, but I've recently switched to GraphicConverter. 
GraphicConverter is faster, supports more file formats, and has more options. To get a feel for 



GraphicConverter's depth, open the Tool palette or explore its preferences. When you save a file, 
GraphicConverter uses a miniature version of the picture for the picture's icon. That icon will 
also show up as a preview in GraphicConverter's Open dialog. GraphicConverter can also extract
PICTs from many games and applications. Note that GraphicConverter requires System 7, and 
won't work with System 6.

There are several reasons you might want to use GIFConverter instead of GraphicConverter. 
Unlike some of the other graphics viewers, GIFConverter works with System 6 or System 7. 
GIFConverter's recommended RAM setting is only 1500K, as opposed to GraphicConverter's 
3000K. If you don't have or can't use Apple's QuickTime extension, GIFConverter is your best 
bet for opening JPEGs. Author Kevin Mitchell (KevinM17) even has a company support area on 
AOL. Use keyword "gifconverter".

ClarisWorks is a great file opener you may already have. It opens files in PICT, TIFF, EPSF, 
MacPaint, and GIF formats. The GIF translator chokes on some GIFs; better to use one of the 
other GIF viewers. If you can't open graphics in ClarisWorks, make sure the Claris Translators 
are in the Claris folder, inside the System Folder.

I'll explain how to open graphics in GIFConverter.

GIFConverter Instructions
1.    Doubleclick GIFConverter to launch it. You'll be greeted by a splash screen reminding you to
pay for GIFConverter. When you send in the shareware fee you'll receive a code that disables the
splash screen.
2.    Choose Open from the File menu.
3.    In the dialog box, navigate to the folder where you saved the GIFs. Normally, the pictures 
will be in the Online Downloads folder, which is inside the America Online folder.
4.    If the pictures don't appear in the Open dialog, click the button labeled "Look inside all 
files". The pictures should appear in the list. Now click the large button labeled "Fix file types 
for shown files".
5.    Click the picture you want to open, then click the Open button. You'll see your picture before
you know it!

Now that you've fixed the file types, you can open the GIFs by doubleclicking them.

GIFWatcher and JPEGview are described in the software section of the FAQ. If you only 
download one viewer, get GraphicConverter or GIFConverter. There are some other graphics 
viewers like CyberGIF, Giffer, Imagery, Seer and Turbo View. They're not listed in the FAQ, 
either because they're old and incompatible with newer machines, or because they offer no 
advantage over the other programs.

8.10    How do I use startup screens?

A startup screen is a PICT graphic with ID=0. It replaces the normal Welcome to Macintosh 
message. If you have a picture that you know is in startup screen format, make sure that it's 
named "StartupScreen" (without the quotes) and place it in the root level of the System Folder. 



That is, it should be inside the System Folder, but not inside any other folders. 

To convert a picture into startup screen format, you can use a program like GIFConverter or 
GraphicConverter. Commercial programs that support the startup screen format include Aldus 
SuperPaint Adobe's PhotoShop, Delrina's ArtWorks, Deneba's Canvas. Some older programs can 
only make black and white startup screens. ResEdit can convert PICTs into startup screens, but it
can't open any other graphics format, which limits its usefulness.

GIFConverter instructions
1.    After you've opened the file you want to use, choose Save As from the File menu.
2.    From the File Type menu, choose Startup Screen.
3.    Click the Options button. From the Number of Colors menu, select the appropriate colors for 
your monitor: black and white, 256 greys, 256 colors, or millions of colors.
4.    Name the file "StartupScreen" (without the quotes) and save it to the root level of your 
System Folder.

GraphicConverter instructions
1.    After you've opened the file you want to use, choose Save As from the File menu.
2.    From the Format menu, choose Startup Screen.
3.    If you don't want GraphicConverter to fill in unused parts of the screen, select "No" from the 
Border menu.
4.    Name the file "StartupScreen" (without the quotes) and save it to the root level of your 
System Folder.

If you get a kick out of startup screens, download Mark Pilgrim's Startup Screen Picker, which 
can randomly select startup screens from a folder full of startup screens. For more information 
send email to f8dy@netaxs.com.

StartupScreenManager by Herbert Putteneers (100143.2154@compuserve.com) promises to do 
even more. Unfortunately, I could never get it to work on my Quadra 605 running System 7.1. If 
it works on your computer, it does have some advantages. StartupScreenManager can randomly 
pick startup screens from a list of pictures in startup screen, PICT, or MacPaint formats, and can 
extract PICTs from applications. It also has a preview mode, and allows you to weight pictures 
so that some play more often than others. StartupScreenManager requires System 7. 

8.11    How do I use disk images and Disk Copy?

 



hen you download a file that ends in ".image", you'll need to copy it to a floppy disk using 
Apple's Disk Copy utility. Disk Copy is available online. Do a file search for "disk copy".

You're probably wondering why you have to use Disk Copy at all. You can just drag the disk 
image to a floppy disk to copy it, right? Well, no. You can't. Here's why: Most Apple software is 
distributed on floppy disks that include an installer program. The installer knows exactly where 
the files are on the disks. If you drag the image file to a floppy, the files won't be in exactly the 
right place, so the installer won't work. Disk Copy produces a bit-for-bit replica of the original 
floppy disk.

Instructions
1.    Decompressed Disk Copy and launch it.
2.    Click the Load Image File button and locate the image file. Disk Copy will read the file into 
memory.
3.    Click the Make a Copy button and insert a floppy disk. The floppy disk must be the same 
size as the image. For an 800K image, use a double density 800K diskette. For a 1.4 Mb image, 
use a high density 1.4 Mb diskette.
4.    After copying the disk image, Disk Copy will eject the floppy disk.
5.    Quit Disk Copy and install the software from the floppy disk you created.

Disk Copy is sensitive to disk errors. In fact, I sometimes use it to check old floppies for bad 
sectors. If Disk Copy reports a media error, there was something wrong with the floppy disk you 
used. Try again using a good disk. 

When working with high-density images, Disk Copy may report "There is not enough available 
memory to work with a disk that size." If that happens, quit Disk Copy, select its icon, and 
choose Get Info from the Finder's File menu. Increase the memory size to 1500K.

                                There's a control panel called MountImage which allows
                           you to install software from the hard drive without
                                copying the software to floppy disk with Disk Copy.
                                Don't use it. MountImage is unreliable, and the program's
                                author recommends using DiskCopy instead.
                                MountImage hasn't been updated in four years.

8.12    How do I install sounds?

Q: What do you want the sounds for?



If you want the sounds for system beeps and chat room sounds, install them in the System file. If 
you want the sounds to play in the chat rooms or to replace the AOL sounds, install them in the 
Online Sounds file. 

Q: What version of the system software are you using?
To find out what system software your Macintosh has, quit all programs and choose About This 
Macintosh from the Apple menu. (Under System 6, it will say "About The Finder".) The window
that appears will report the version of the system software you're using.

Installing system sounds under System 6    Use keyword "file search" and search for 
"sound manager". Download the Sound Manager package and use the Sound Mover utility to 
install the sounds into your system file. Sound Mover can also remove sounds.

Installing system sounds under System 7    Quit all applications and desk accessories, 
then drag the sound's icon to the icon of the System Folder. (Do NOT drag the sound into the 
System Folder WINDOW!) When the System Folder is hilited, release the mouse. The system 
will ask if you want the sound placed in the system file. Click OK. If the system reports that not 
enough memory is available, restart the machine with extensions off. To do this, choose Restart 
from the Special menu, then press the shift key and keep it down until your hard drive icon and 
trash can icon appear.

To remove sounds under System 7, doubleclick the System file. When the window opens, locate 
the sound and drag it to the desktop.

Installing sounds in AOL's Online Sounds file
To install sounds for use only with AOL, you'll need Sound Mover. Sound Mover is part of the 
Sound Manager Package by Riccardo Ettore. The current version of Sound Mover is 1.9. To 
locate Sound Manager Package, do a file search for "sound manager". The instructions are the 
same for System 6 and System 7.

Instructions
1.    Quit all other programs and launch SoundMover
2.    The left window shows sounds in the system file. Unless you want to use those sounds, click 
the Close button. 
3.    Click the Open button. Navigate to the Online Sounds file, which is inside the Online Files 
folder. Open the Online Sounds file. 
4.    In the right window, click the Open button and navigate to the sounds you want to use. 
5.    Select the sound you want to move and click the Copy button. Bingo! Your new sounds are 
now in the Online Sounds file.

Replacing the standard AOL sounds
To replace the standard AOL sounds, move your new sounds into the Online Sounds file, using 
the instructions above. Then select the sounds you want to replace and choose Remove from the 



Edit menu. Finally, select the sounds you added and choose Rename from the Edit menu. Be sure
to give the new sound the same name as the old sound. Here are the names for the standard AOL 
sounds: 

      NAME                          SOUND              
___________    ____________________
    252                    Instant Message
    258                    You've got mail!
    259                    File's done!
    Goodbye            Goodbye
    Welcome            Welcome

8.13    How do I install DAs (Desk Accessories)?

System 6 instructions    Locate Apple's Font/DA 
Mover utility. If it's not on your hard drive, look for it 
on your system disks. After using Font/DA Mover to 
install the DA, the DA will appear under the Apple menu. 
Font/DA Mover can also remove DAs.

System 7 instructions    Quit all applications and desk accessories. Doubleclick the DA's 
suitcase. Now drag the DA from the suitcase onto the desktop. After moving the DA to the 
desktop, you can doubleclick it to launch it. If the system reports that not enough memory is 
available, restart the machine with extensions off and try again. To do this, choose Restart from 
the Special menu, then press the shift key and keep it down until your hard drive icon appears on 
the desktop.

As a System 7 shortcut, you can quit all applications and drag the suitcase to the icon of the 
System Folder. When the System Folder icon is hilited, release the mouse button. The computer 
will strip off the suitcase and place the DA in the Apple Menu Items folder. To remove DAs, 
move them out of the Apple Menu Items folder or wherever they were stored. You can trash DAs
just like any other file.

8.14    How do I install fonts?

Again, the answer depends on the version of your Macintosh's system software.

System 6 instructions    Locate Apple's Font/DA Mover utility. If it's not on your hard drive,
look for it on your system disks. Font/DA Mover is used to install fonts into the System file. One
exception: for PostScript fonts, the printer font should be in the System Folder.

System 7.0 instructions    Quit all applications and desk accessories, then drag the font's 
icon to the icon of the System Folder. (Do not drag the sound into the System Folder window.) 
When the System Folder icon is hilited, release the mouse button. When asked if you want to 
install the fonts, click OK. 

To remove bitmapped and TrueType fonts under System 7.0, doubleclick the System file. When 



the window opens, locate the font and drag it to the desktop. To remove a PostScript font, 
remove it from the Extensions folder.

System 7.1+ instructions    Drag the font's icon to the System Folder, as above. You can 
also drag the font directly to the Fonts folder, which is inside the System Folder. To remove the 
font, drag it out of the Fonts folder.

If the system reports that not enough memory is available, restart the machine with extensions 
off. To do this, choose Restart from the Special menu, then press the shift key and keep it down 
until your hard drive icon appears.

                           TrueType fonts work out of the box with System 7. 
                                System 6 users will need Apple's TrueType extension 
                                to use TrueType fonts. The font's file description should 
                                state what format the font is in.

8.15    How do I install FKEYs?

FKEYs are little programs you can install in the system software or in individual applications. 
Macs come with several built-in FKEYs. Pressing Command-shift-1 activates the FKEY that 
ejects floppy disks. Command-shift-3 takes a picture of the screen. 

If you own the payware programs SuitCase or MasterJuggler, use them to install FKEYs. 
Otherwise, download Adam Stein's shareware FKEYMaster or James Walker's CarpetBag. 
Installing an FKEY into the system file makes it available to all applications. Alternatively, you 
can install FKEYs into individual applications. FKEY installers can also remove FKEYs.

Many older FKEYs don't work with System 7. If an FKEY fails to work under System 7, throw it
away. It's not worth worrying about.

8.16    What is "zero K needed, zero K available"?

Downloads occasionally become corrupted due to phone line noise, producing a bad download. 
One symptom of a bad download: doubleclicking the file produces a message saying "There is 
not enough memory to open "file name" (zero K needed, zero K available). Bad downloads don't 
always produce this message, of course.

If you see this message, use keyword "credit" to get a reimbursement for the time spent 
downloading the file. Then throw the file away and download it again.

 



.17    What does "not enough access privileges" mean?

That message comes from the Macintosh, not from AOL. It means that you tried to move or 
delete files from protected folders. This feature is unique to the Performas.

To turn off the protection, choose Control Panels from the Apple menu. Doubleclick the 
Performa control panel, then turn off "System Folder Protection" or "Applications Folder 
Protection", depending on where the files are that you want to delete. As a rule of thumb, don't 
put any software in the System Folder unless it has to be there.

8.18    What is error of type "so and so"?

Launching old, weird software may give you an error message. There's a file on AOL called Easy
Errors by Dave Rubinic (DaveR9), which explains what the error numbers means. For instance, a
type 15 is a segment loader error. In non-technical, jargon-free terms, I'm going to explain what a
segment load error means:

There was a segment. See? And it was going to be loaded. Are you still with me? Alright. Well, 
see, just when this segment was about to load, there was an error. It was a type 15 error!

In other words, error numbers don't mean squat to most people. The error messages do have 
certain meanings, but the meanings are mostly useful to the program's author, who can rewrite 
the software.

The most common error message is a type 1 error. This usually means one of two things. The 
program may need more memory. Click the program's icon, choose Get Info from the File menu, 
and increase the memory size in the lower right corner of the window. This will occasionally fix 
the problem. Often, however, a type 1 error simply means the program is old and incompatible 
with newer computers or newer versions of the system software. There's nothing you can do 
except to throw away the program.

                          SOME ERROR CODES 
                  AND THEIR (NON) MEANINGS
_____ _______________________________________
    1          bus error
    2          address error
    3          illegal instruction error
    4          zero divide error
    5          check trap error
    6          overflow trap error
    7          privilege violation error
    8          trace mode error



    9          line 1010 trap error
 10          line 1111 trap error

You may occasionally encounter a "co-processor not installed" error. You would think this only 
occurs on Macs which lack math co-processors (fpus). In fact, it also occurs on fpu-equipped 
Macs, and it happens with programs that don't require an fpu.


